
Changes in CabWriter Version 1.1.0 

 

Note: 

This release fixes a number of problems introduced with the release of SketchUp 2018 Pro. Also, a 

number of images in this document were created with a beta version of CabWriter 2.0.0 and depict cope 

& stick frame and panels. Cope & stick frame and panel functionality is not available in this release but 

will be available in CabWriter 2.0.0. 

New Functionality 

1. Added and changed some defaults on the Carcass tab of CabWriter Settings in the General, Back and 

Joinery sections. The General section is new and has one default called Top/Bottom/Stretcher 

Recess. This default is implemented and works as described in 2 below. The Back and Joinery 

sections appear in the Carcass tab but are not yet implemented. These defaults will become 

important and active when we implement dado, rabbet and packet joinery. 

 

 
 

2. The default called Top/Bottom/Stretcher Recess in the General section of the Carcass tab permits 

the recessing of the top, bottom, top stretchers, mid stretchers and any fixed shelves. The default is 



0”. 

 

3. Renamed the Re-Name Component tool to Make CabWriter Component, changed its icon from  

to  (which I don’t like but will change again later) and also changed its functionality. 

In the past, in order to add a custom component to a CabWriter cabinet you first had to model the 

component in primitives using native SketchUp tools, select all the primitives and then use 

SketchUp’s Make Component  tool to make a SketchUp component. Next you used the Re-Name 

Component  tool to turn the SketchUp component into a CabWriter Component. 

 

I have eliminated one step in this process. To add a custom component to a CabWriter cabinet you 

first model the component in primitives using native SketchUp tools, select all the primitives and 

then use the Make CabWriter Component  tool to make a CabWriter Component. This allows 

you to go directly from selected primitives to a CabWriter Component. 

 

You can still select a component and use the Make CabWriter Component  tool to turn a 

SketchUp component into a CabWriter component, or select a CabWriter component and use the 

Make CabWriter Component  tool to rename or change attributes of the component. However, 

the restrictions are that the selection you pass to the Make CabWriter Component tool must either 

be all primitives or one component, and that component’s definition name must be unique (not 

currently in the model’s definition list). Primitives plus anything else or more than one component 

will result in an error message. 

If the user selection is primitives when using the Make CabWriter Component  tool the Make 

CabWriter Component dialog box will look similar to the following: 



 

 

However, if the user’s selection is a CabWriter component prior to selecting Make CabWriter 

Component tool it will look similar to this: 

 

 

Lastly, if the user’s selection is a SketchUp component (non-CabWriter component) prior to selecting 

the Make CabWriter Component tool it will look similar to this: 



 

 

In all cases the component can be changed to a CabWriter component or a CabWriter component 

renamed. This change was made to streamline the creating of a CabWriter component. There will be 

future changes that will further enhance and streamline the process. 

 

In addition to the look and name change of this tool, a lot of functionality has changed. There are 

three sections to this dialog box. The first section, Current Component Instance Names, simply tells 

the user what the current definition name and instance name are. These fields will not change until 

a successful execution of this tool is completed. Note, for this reason they are grayed out and 

cannot be changed. 

 

The second section, Changes to Component Instance Names & Protection, is where the user will 

make all the changes desired before execution the tool with the OK button. Inside this section some 

fields are labeled in blue italics, one in red italics and the rest are normal black. The blue italics fields 

contain test that will be assembled into a component definition name and displayed in the third 

section in the field called Definition Name. This will happen in real time so that you will see the 

changes as you make them. The red italics label, Sub-Type, is a selection from a drop down list that 

will change as a function of the choice made in the blue italics Component Type drop down. The 

Sub-Type field is not part of the definition name, but rather a classification of a Component Type, 

which is used only to determine the appropriate information to write in the component’s CutList 

Bridge attributes. 

 

Starting at the top of the second section the Cabinet Number field is where the user supplies the 

cabinet number that this new CabWriter component will be assigned. It must be a valid cabinet 



number and that cabinet must currently exist in the model. The user can type the number into the 

field without regard to capitalization; CabWriter will correct for capitalization. But the cabinet 

number must start with the letter C followed by a non-zero integer and end in either U or L. 

 

Next is Component Type. The user must choose a component type from the drop down; blank is not 

a component type. If the Component Type contains the # symbol, the user must then input a non-

zero integer into the unlabeled field next to Component Type. If the selected Component Type does 

not contain a # symbol the unlabeled field will be grayed out. 

 

Next is the Sub-Type field. This field will change each time a Component Type selection is made. The 

user can select blank or any item on the list. If blank is chosen the new component will have CutList 

Bridge attributes initialized to a Milled Part(s) with blank fields except for the correctly assigned Sub-

Assembly and CabWriter Protection. If an item other than blank is chosen the component will have 

correctly assigned attributes based on the current CabWriter defaults, Sub-Assembly and CabWriter 

Protection. 

 

The next field, Description, is where the user supplies the description part of the definition name. 

The description part is the part that comes after the cabinet number and component type. The user 

does not supply the space between the cabinet number/component type and the description; 

CabWriter automatically inserts that. 

The Instance Name field is where the user supplies the new component’s instance name. 

 

To provide CabWriter protection for this new component the user chooses Yes from the Set 

CabWriter Protection? Drop down; or No if no CabWriter protection is requested. 

 

Lastly, the third section, New CabWriter Component Instance Names & Protection, show the 

compiled results from changes made in the Changes to Component Instance Names & Protection 

section. This is what will be written to the new component along with the appropriate CutList Bridge 

attributes when the user clicks on the OK button. The user should carefully inspect this before doing 

so. In addition, once the operation is complete it would be wise for the user to select the new part 

and examine its attributes with the Extended Entity Info dialog box. 

 

Choosing the Cancel button will return the selection to its original state. 

 

NOTE: The Make CabWriter Component cannot be used to change the Instance Name of a normal or 

CabWriter component. Use the Entity Info dialog box to change an Instance Name. 

4. Changed the name of the dialog box opened by the View License and Check for Updates command 

in the Extensions > CabWriter menu. Changed it from Active CabWriter License to View License and 

Check for Updates. 

5. Changed the default value for Draw Alignment Slot on both Base and Upper Cabinet tabs to “No”. 

6. CabWriter now draws End Sheet(s) when Sheet Stile Draw? Checkbox is unchecked; i.e. End Sheet(s) 

are drawn whether the Sheet Stile is checked or unchecked. If Sheet Stile Draw? Is unchecked the 



End Sheet will extend to the same plane as the door/drawer fronts front plane. This change only 

affects Sheet Stiles. In the next beta release it will work the same way for End Panel Stiles and 

Opening Stiles. This change is meant to benefit frameless designs. 

7. Completed the frameless end panel inclusion; i.e. End Sheet(s), End Panels(s) and End Opening(s) 

are now drawn whether or not their end stiles are drawn. If their end stiles are not drawn the front 

edge of the end sheet, end panel or end opening will extend to the face plane for the door and 

drawer fronts. See example of frameless below. 

 

 

Note: When an End Opening is created in a cabinet with End Opening Stile(s) drawn the material 

type and name is the same as the Carcass. When an End Opening is created in a cabinet with End 

Opening Stile(s) NOT drawn the material type and name is the same as the End Panel. 

8. When creating a CabWriter project with the Create Project tool, a project name is assigned and will 

appear in the Project Name field of the Project tab. This name can be changed at any time after 

creating a CabWriter project; simply change it in the Project Name field. 



9. The menu Extensions > CabWriter > View License and Check for Updates now includes a Licensed 

Version (formerly just Version)field and an Installed Version field. Notice in the image below that the 

Licensed Version is 1.0.0, but the user has installed a beta test version that is newer than the 

Licensed Version. The message below no longer tells the user if the installed version is up to date or 

there is a newer on available. Rather it simply informs the user of the latest available version. 

 

10. Added two new defaults, one each to the Base Cabinets and Upper Cabinets tabs called Back Corner. 

They are dropdown options with the choices Angled and Squared. These defaults determine 

whether the back corner is constructed at a 45 degree angle or square. 

When Squared is selected for the Back Corner the angled Shelf Support is not drawn and the Shelf 

Support shelf holes are consequently not drawn. In their place shelf holes are drawn in the Left and 

Right Back. See examples below. 

 

  



 

 

Note the shelf hole arrangement and the shelf design 

and placement. The L-shaped shelves are drawn by 

CabWriter. The straight shelves, shown right,  were 

simply L-shaped shelves modified in Component Edit 

mode and one of them rotated. The Diagonal Corner 

cabinet (box) is now also available with a square corner. 

Note in these images that CabWriter provides two 

columns of shelf holes in the backs of the cabinet that 

match the shelf holes in the box sides. This is so you can 

have standard L-shaped or straight shelves (image on 

right).  

 

 

 

 



11. The Insert a Door, Insert a Drawer and Create a Back Panel now give the user the option of using the 

cabinet’s stored defaults or the current CabWriter Settings defaults. In the unlikely example below, 

the cabinet was constructed a frameless cabinet with End Sheet end panels. The CabWriter Settings 

were modified to use cope & stick back panels and then the back panel was added using those 

settings, not the cabinet’s stored settings. 

 

 

12. When using the Create a Back Panel tool the Back Panel dialog box input field is now case 

insensitive. See legitimate input in image below. 

13. Added a new default on the Carcass tab at the bottom of the Toe Kick section called ‘Draw Toe Kick 

Frame?’. The options are Yes or No. Yes means that the entire ladder base is drawn. No means that 

the stretchers, ribs, and ties are not drawn leaving only the applied trim faces. See the images 

below. 

 



 

 

14. Combo Drawers drawn without a mid-stile now have one Drawer Support between them as 

opposed to a Left Drawer Support and Right Drawer Support. This is true for all base cabinet types 

that permit Combo Drawers. If the mid-stile is drawn then there is both a Left Drawer Support and 

Right Drawer Support. Thickness of the single draw support is the same as the box sides. See the 

Base Cabinets tab on the next page. 

  



 

 

Fixes 

1. Made changes to the Drawers tab of the CabWriter Settings tab. For both the Base and Upper the 

section called Frame & Panel has been divided into two sections; one called Drawer Face Style and 

the other Frame & Panel. 

 

In both Base and Upper Frame & Panel sections changed Dado depth to Groove Depth. 

2. Fixed a problem where the user could not use any of the CutList Bridge File commands on a non-

CabWriter project. 

3. Fixed a problem with the Create a Back Panel tool. Back panels with larger than two panels resulted 

in the last panel being a width stretching from the beginning of the second panel to the end of the 

last panel. The user couldn’t visually see this on the basic panel type unless they looked at its 

dimensions or move it out of the frame and panel assembly. 

4. Fixed a problem with diagonal corner cabinet. If the Cabinet Style was Frameless and the End Stiles 

were drawn, the door did not position correctly. 

5. Fixed the Door/Drawer Panel Profile raised.skp file, which was cause an error because it contained a 

construction line. 



6. Fixed a problem with Diagonal Corner and Lazy Susan cabinet where the End Opening Fillers were 

not drawn correctly. 

7. Fixed a problem with using Make CabWriter Component to add a Mid Stile to a Face Frame, which 

resulted in a SketchUp error message. The CutList Bridge defaults for Doors and Drawers were not 

loaded. 

8. Fixed the Make CabWriter Component dialog box so that the Description and Instance Name input 

fields now permits pasting into them. 

9. Fixed a problem where, when bottom trim is drawn, on a Lazy Susan cabinet the trim was not placed 

correctly. 

10. Fixed a problem where when checking thickness, tongue length and tongue width in cope & stick 

creation, the comparison of dimensions could fail due to floating point inaccuracies. 

11. Fixed a problem in SketchUp 2018 that did not permit the drawing of combo drawer fronts. 

12. Fixed numerous problems created by SketchUp 2018. The explode method returns an array of 

entities. Those entities in 2018 can now include class AttributeDictionaries. 

13. Fixed a problem when drawing a multi-box cabinet with a Lazy Susan or Diagonal Corner box, and 

depending on the direction it was drawn, the front applied face of the ladder base was drawn short 

and with a butt end instead of a miter end. 

14. Fixed a problem where the ladder base ties could be drawn too long by 1” in certain multi-box 

cabinet configurations involving corner boxes. 

15. Removed a redundant and non-functional default from the CabWriter Settings dialog box Face 

Frame tab. Blind Corner Mid Stile is not needed; its functionality is provided by Drawer Mid Stile. 

16. CabWriter allows users to save and open defaults to a file, which is very powerful. These files can be 

shared by simply emailing them to someone or receiving them in the email. There are two potential 

and serious problems with this: first those files can be corrupted since they are merely text files.; 

second they can become obsolete if they were generated on an older version of CabWriter and 

defaults were added, deleted or names changed since. So CabWriter now has a registry of valid 

defaults. This registry is created when a user opens a CabWriter project with the Create Project tool 

or uses the Re-Load Factory Settings tool. When a file is saved it checks for illegal default names and 

blank defaults. A message informs the user to check for and correct blanks in the CabWriter Settings 

tabs. When a file is opened and a blank is read in it will also display in the CabWriter Settings tabs. 

  



Changes in CabWriter Version 1.0.2 
Note: Release 1.0.2 has additional defaults not in previous versions. In order to pick them up in models 

created in previous versions you must use the Re-Load Factory Settings tool and save your file. Cabinets 

drawn after this process will include the new defaults. 

New Functionality 

1. Added a new command item called Export to CutList Plus fx with DXF shown in the image at right. 

Notice also that CutList Bridge has been 

changed to CutList Bridge DXF. The Export 

to CutList Plus fx with DXF command is 

only available with a CNC license. 

 

This new command first produces a .cwx 

cut list file and places it in the same folder 

as the model’s .skp file, called the root 

folder, and then creates one DXF file for 

each Sheet Good type component 

selected, and places that file in a relative 

folder whose relative path is: 

 

name/CW_DXF_Files 

 

where name is the name of the model’s 

.skp file. 

 

The user can now open CutList Plus fx by 

clicking on the .cwx file and produce optimized DXF outputs by using CutList Plus fx command File > 

Export DXF or pressing F4. 

 

Note: The user need create only one .cwx file. Simply select all components you wish included in the 

cut list and use the Export to CutList Plus fx with DXF command to create the .cwx. CutList Bridge 

DXF will tell CutList Plus fx, through file pointers in the .cwx, which components are Sheet Goods and 

should be included in its DXF output. If the user wishes CutList Plus fx to produce DXF files output 

command Export to CutList Plus fx with DXF must be used; command Export to CutList Plus fx will not 

produce the individual component DXF files, nor the pointers in the .cwx file needed to instruct 

CutList Plus fx to do so. 

2. Added a default called ’End Panels to 

Floor?’ and modified default ‘Carcass 

Sides to Floor?’. On the Upper 

Cabinets tab of the CabWriter Setting 

in the Refrigerator Upper section 

shown at right you will see a new 



default called ‘End Panels to Floor?’. 

 

When ‘Yes’ is chosen and an End Panel Stile or End Sheet Stile is specified the end panel or end 

sheet will be drawn and extended down to the floor. When ‘No’ is chosen the end panel or end 

sheet will stop at the bottom of the cabinet. 

 

The ‘Carcass Sides to Floor’ default has been modified. It works similar to ‘End Panels to Floor?’ 

except it only applies to the cabinet sides and no longer affects how end panels or end sheets are 

drawn. 

3. Modified the defaults file called Frameless that is distributed with the CabWriter installation file. It 

includes the new default ‘End Panels to Floor?’ and default check box ‘Mid Rail’ on the Upper Stiles 

& Rails section of the Face Frame tab is now unchecked. 

 

Fixes 

1.  Fixed a problem with DXF outputs where the G-Axis (Y-Axis) position of all component points could 

be shifted. This didn’t cause a problem with current optimization tools such as Cut2D Pro because 

they automatically moved each component to the origin before placing it. CutList Plus fx, however, 

expected that all components already be placed at the origin. 

2. Fixed a CabWriter Settings default problem on the Upper Cabinets tab. The default called ‘Carcass 

Sides to Floor?’ in the Refrigerator Upper section failed to save a change from ‘Yes’ to ‘No’ when the 

Update button was pressed. Hence the user could not drawer a refrigerator cabinet with sides that 

stopped at the bottom of the cabinet. 

3. Fixed a problem where Extensions > CabWriter > View License and Check for Updates resulted in an 

error. 

4. Changed an error message to be more user helpful. Message changed from “There are too few or 

too many Corner stiles included in the Cabinet.” to “Asymmetrical CabWriter Settings on Face Frame 

tab. Both stiles on either side of a corner cabinet need to be drawn or neither one drawn because of 

the symmetrical nature of a corner cabinet.”. 

5. Fixed a problem with the Project and Face Frame tabs of the CabWriter Settings. When Frameless is 

chosen for Cabinet Style on the General section of the Project tab it should be reflected on the Face 

Frame tab as all cleared ‘Draw?’ check boxes. However, Upper Stiles & Rails Mid Rail check box was 

incorrectly set.  

6. Corrected a default name. In the Cut List tab of the CabWriter Settings in the Carcass Oversizing 

section Shelves Width should have been Shelves Length. 

7. Corrected two default names. In the Cut List tab of the CabWriter Settings in the End & Back Panel 

Oversizing section, Sheet Width and Sheet Length should have been Panel Width and Panel Length. 

8. Made a change to the sections on the Doors tab of the CabWriter Settings dialog box. Broke both 

the Base and Upper Doors Frame & Panel into two sections called Doors Style and Doors Frame & 

Panel. Also changed both Base and Upper Rail Width (Default) to Top Rail Width. 



Changes in CabWriter Version 1.0.1 

New Functionality 

1. Changed the way drawer boxes are reported in the cut list. Drawer Boxes are an Other Item. Since 

drawer boxes are not drawn with individual parts, the box is simply a cubic box with overall 

dimensions. Most cabinetmakers have drawer boxes built by a third party, so they are reported as 

Other Item. 

 

In the exported .csv file intended for Microsoft Excel or OpenOffice Calc they will appear this way: 

Other 
    

 
Comp # Sub-Assembly Description Copies Material Name 

 
C3-10 C3LDWB4 C3LDWB4 Left Drawer Box 1 C13LDWB4 [H 4 1/4" W 7 13/16" D 21"] 

 
C3-11 C3LDWB4 C3LDWB4 Right Drawer Box 1 C13LDWB4 [H 4 1/4" W 7 13/16" D 21"] 

 
C3-7 C3LDWB1 C3LDWB1 Drawer Box 1 C13LDWB1 [H 6" W 17 1/4" D 21"] 

 
C3-8 C3LDWB2 C3LDWB2 Drawer Box 1 C13LDWB2 [H 4 1/4" W 17 1/4" D 21"] 

 
C3-9 C3LDWB3 C3LDWB3 Drawer Box 1 C13LDWB3 [H 4 1/4" W 17 1/4" D 21"] 

 

 

     

 

In CutList Plus fx Other Items drawer boxes will appear this way: 

Sub-Assembly Category Item Description Quantity 

C13LDWB4 [Not Categorized] C13LDWB4 [H 4 1/4" W 7 13/16" D 21"] C13LDWB4 Right Drawer Box 1 

C13LDWB4 [Not Categorized] C13LDWB4 [H 4 1/4" W 7 13/16" D 21"] C13LDWB4 Left Drawer Box 1 

C13LDWB3 [Not Categorized] C13LDWB3 [H 4 1/4" W 17 1/4" D 21"] C13LDWB3 Drawer Box 1 

C13LDWB2 [Not Categorized] C13LDWB2 [H 4 1/4" W 17 1/4" D 21"] C13LDWB2 Drawer Box 1 

C13LDWB1 [Not Categorized] C13LDWB1 [H 6" W 17 1/4" D 21"] C13LDWB1 Drawer Box 1 

 

In Excel or OpenOffice Calc the Material Name reports the component name with overall 

dimensions in brackets []. In CutList Plus fx it is the Item column with this information. The 

component and bracket notation was added to make it easier in future revisions to create more 

useful reporting of drawer boxes. 

Fixes 

1. Fixed a problem with the Divided Upper and Divided Base cabinets where the drawer box height 

and position could be incorrect. 

2. Fixed a problem with Divided Upper and Divided Base where drawer slide holes were not drilled 

at the right height when the bottom was inset and protruding above the bottom rail. 

3. Fixed a problem where an error was raised when trying to ‘Insert a Drawer’ at the top of either a 

Divided Base or Divided Upper. 

4. If the user selected a non-component instance (for example primitives) and then chose the Re-

Name Component tool an error would be raised. Now a message box informs the user that 



something other than a component instance was chosen. The Re-Name Component tool always 

expects a component instance. 

5. Occasionally the user may create a modeling mistake that produces a message such as “A 

Component Type Top, Shelf or Bottom is not accompanied by a Back in the selection.” When 

attempting to create a cut list. This message is not helpful. It will now produce a message such 

as “A Component Type Top, Shelf or Bottom is not accompanied by a Back in the selection. The 

component name is C2LB1 Top.”  This message is much more specific. 

6. When a Divided Base or Divided Upper shared a component space with an adjacent cabinet, 

such that a rectangle chose to ‘Insert a Drawer’ or ‘Insert a Door’ required the user to choose 

the intended cabinet to access its defaults, sometimes it would choose the wrong cabinet. 

7. Fixed a problem where one of the Lazy Susan Base doors was drawn too wide. 

8. Fixed a problem when drawing a Lazy Susan Base attached to another cabinet and then using 

any Re-Draw or other cabinet editing tool the sides of the Lazy Susan Base and the connected 

cabinet would occupy the same space. The problem was that the phantom connector stile 

between them was set to ¾” wide (one side width) instead of 1 ½” wide (two side widths). 

9. Fixed a problem with Drawer Base Bank Combo and Standard Base w/Drawer and two drawers 

specified. If the drawers were specified as a slab drawer front the drawer fronts were not drawn 

and a Ruby exception was raised. 

10. Fixed a problem where stile types ‘corner_right_end_connector’ and 

‘corner_left_end_connector’ failed to draw the ties and trim on corner cabinets. 

11. Fixed a problem where stile types ‘corner_right_end_connector’, 

‘corner_right_pivot_connector’,  ‘corner_left_end_connector’ and 

‘corner_left_pivot_connector’ were sized incorrectly when a Re-Draw All or Selected Cabinets, 

Edit Story Stick or Edit Cabinet tools were used. 

12. Fixed a problem where Right End Rib and Right End Stretcher were misplaced when a 

corner_right_pivot stile was used. 

13. Updated the Frameless.cwd file in the cabwriter\cabwriter_defaults folder to reflect pure 

frameless construction. 

14. Fixed a problem where the active model’s library ‘Temp’ and key ‘CabWriter Settings Page’ was 

not initialized. If the CabWriter Settings dialog box was open when SketchUp was last closed on 

the next opening of SketchUp the Re-Load Factory Settings tool raised an exception until the 

CabWriter Settings dialog box was opened another way. 

15. Fixed a file incompatibility problem between Mac OSX and Windows that caused saved .cwd 

files to be unreadable on a Mac if created on a PC. Windows/Dos UTF-8 produces a LF and CR 

when writing files. Mac OSX doesn’t want to see a CR. 


